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Introduction

Introduction

Thank you for purchasing the Canon S300 Bubble Jet Printer. This User's Guide provides
complete explanations of the features and functions of the printer.

This guide uses the following symbols to indicate important information. Always observe
these instructions.

Warning » Instructions that, if ignored, could result in death or serious personal injury
caused by incorrect operation of the equipment.
These must be observed for safe operation.

Caution » Instructions that, if ignored, could result in personal injury or material
damage caused by incorrect operation of the equipment.
These must be observed for safe operation.

Important »  Prohibited actions that, inadvertently performed, could result in equipment
damage, faults or impaired product quality.
These must be avoided for correct operation.

Windows Information for Windows® only.

Information for Macintosh® only.



How to Use This Manual

How to Use This Manual

To view this User’s Guide, we recommend that you use Acrobat® Reader™ 4.0 or Acrobat
Reader 3.0. Please note that screens displayed by Acrobat Reader 3.0 are slightly different.

Use this button to enlarge the Displays the previous page.

E{, viewing screen. Select this button in 1

= the tool bar and click within the
screen.

Displays the next page.
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Safety Precautions

A\ Safety Precautions

Please read the safety warnings and cautions provided in this manual to ensure that you
use the printer safely. Do not attempt to use the printer in any way not described in this

manual.

Warning »  You may cause an electric shock/fire or damage the printer if you ignore
any of these safety precautions.

B Choosing a location

Do not place the printer close to flammable solvents such as alcohol or thinners.

B Power supply

Never attempt to plug in or unplug the printer from the power supply when your hands
are wet.

Always push the plug all the way into the power outlet.

Never damage, modify, stretch or excessively bend or twist the
power cord. Do not place heavy objects on the power cord.




Safety Precautions

Never plug the printer into a power socket that is shared with other
equipment (extension cord, double adapter, etc.).

Never use the printer if the power cord is bundled or knotted.

If you detect smoke, unusual smells or strange noises around the printer, immediately
unplug the printer at the power supply and call for service.

Periodically unplug the printer and use a dry cloth to wipe off any dust or dirt that has
collected on the plug and power outlet. If the printer is placed in a location exposed to a
lot of dust, smoke or high humidity, the dust that has collected on the plug may absorb
moisture and cause insulation failure and fire.

Bl Cleaning the printer

Use a damp cloth to clean the printer. Never use flammable solvents
such as alcohol, benzene or thinners.

If flammable solvents come in contact with electrical components inside the
printer, it could cause a fire or electric shock.

Always unplug the printer from the power outlet before cleaning the printer.

If you accidentally switch the printer on while cleaning it, you could injure yourself or damage the printer.



Safety Precautions

B Maintaining the printer

Do not attempt to disassemble or modify the printer. There are no user-serviceable parts
inside the printer.

The printer contains high-voltage components. Never attempt any maintenance procedure not described in
this guide.

B Working around the printer
Do not use flammable sprays near the printer.

This could cause a fire or electric shock if the spray comes into contact with electrical components inside
the printer.

Never put your hands or fingers in the printer while it is printing.

Do not place metal objects (paper clips, staples, etc.) or containers of flammable
solvents (alcohol, thinners. etc.) on top of the printer.

If any foreign object (metal or liquid) falls into the printer, unplug the power cord and call
for service.

10



Safety Precautions

Caution >» You may cause injury or damage the printer if you ignore any of these
safety precautions.

B Choosing a location

Do not install the printer in a location that is unstable or subject to excessive vibration.

Do not install the printer in a location that is very humid or dusty, in direct sunlight,
outdoors, or close to a heating source.

To avoid the risk of fire or electric shocks, install the printer in a location with an ambient temperature range
of 41°F to 95°F (5°C to 35°C) and humidity of 10% to 90% (condensation free).

Do not place the printer on a thick rug or carpet.

Ensure that the area around the power outlet is kept clear at all times
S0 you can easily unplug the power cord if necessary.

When moving the printer, carry the printer at both ends.

11



Safety Precautions

B Power supply

Never remove the plug by pulling on the cord.

Do not use an extension cord.

If you do not intend to use the printer for a long period of time, unplug it after turning it off.

Never use a power supply voltage other than that supplied in the country of purchase.

The correct power supply voltage and frequency is as follows:
USA/Canada: AC 120V, 60Hz

Europe: AC 230V+10%, 50Hz

Australia: AC 240V, 50Hz

M Printheads and ink tanks

For safety reasons, store printheads and ink tanks out of the reach of small children.

If a child ingests any ink, consult a doctor immediately.

12



Safety Precautions

Do not shake printheads or ink tanks.

Ink may leak out and stain clothing or the surrounding area.

Never touch the electrical contacts on a printhead after printing.

The metal parts may be very hot and could cause burns.

13



Printer Parts and Their Functions

Printer Parts and Their Functions
* Front View

* Rear View

¢ [nside the Printer

* Operation Panel
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Front View

Printer Parts and Their Functions

Operation panel
For details, refer to
"Operation Panel".

Paper output tray

Front cover

Open to replace the
ink tanks or remove
jammed paper.

Paper guide

When loading paper, ensure
that the left edge touches
this guide.

To move the paper guide,
pinch the guide and slide in
the appropriate direction.

Paper rest

Sheet feeder
Load paper here.
Paper feeds
automatically, one
sheet at a time.

Front View 15



Rear View

Printer Parts and Their Functions

USB port
Connects the printer to a
computer through a USB port.

Rear View 16



Printer Parts and Their Functions

Inside the Printer

Paper thickness lever
Adjusts the gap between the printhead and the surface
of the printing paper.

Printhead holder

Printhead lock lever
! v Install the printhead here.

Locks the printhead into the holder.
Once the printhead is installed, do not touch this lever.

Inside the Printer 17



Operation Panel

Printer Parts and Thelr Functions

POWER button

Press to turn the printer
on or off. The printer will
initialize, then print.

RESUME/CANCEL button

Press to resume printing once an error has been
resolved. To cancel printing in progress, press this
button.

QU&

POWER lamp

Off: The printer is turned off.

Green: The printer is ready to print.

Flashing green: The printer is preparing to print, or is currently printing.
Flashing orange (two or more between green flashes): An error has occurred

and the printer is not ready to print.

Flashing orange and green alternately: An error has occurred that will require
you to contact the Customer Care Center.

Operation Panel 18



Printer Driver Functions (Windows)

Printer Driver Functions (Windows)

* Opening the Printer Properties Dialog Box
* Printer Properties Dialog Box Description
* BJ Status Monitor Functions

* Canceling a Print Job

* Uninstalling Printer Drivers
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Printer Driver Functions (Windows)

Opening the Printer Properties Dialog Box

The Printer Properties dialog box can be opened from within an application or directly from
the Windows Start menu.

B Opening the Printer Properties dialog box from your application program

This method is generally used to specify printer settings just before printing.
The operations may vary slightly depending on your application program. This section
describes only the general procedure for opening the Printer Properties dialog box.

7 In your application, select the command to print a document.
The Print dialog box can usually be opened by selecting Print from the File
menu.

Z Ensure that Canon S300 is selected in the Name field, then click
Properties.

The Printer Properties dialog box will appear.

Note » Depending on your application program, the command and menu names
may differ, and there may be more steps involved in opening the Printer
Properties dialog box. For further details, see the user's manual for your
application.

Opening the Printer Properties Dialog Box 20



Printer Driver Functions (Windows)

B Opening the Printer Properties dialog box directly from the Start menu

This method is used for maintenance operations such as printhead cleaning, or to
specify printer settings common to all application programs.

When the Printer Properties dialog box is opened from the Start menu, additional tabs
appear, including the Details tab. These do not appear when the Printer Properties
dialog box is opened from within an application.

For further information about these additional tabs, refer to your Windows

documentation.
7 Click Start, then select Settings, then Printers.

For Windows XP, click Start, then Control Panel, then Printers and Other
Hardware, then Printers and Faxes.

Z  Select the Canon S300 icon.

3 Open the File menu and select:

* Windows 98/Windows Me - Properties
e Windows 2000/Windows XP - Printing Preferences

The Printer Properties dialog box will open.

Opening the Printer Properties Dialog Box 21



Printer Driver Functions (Windows)

Printer Properties Dialog Box Description

e Main Tab

* Page Setup Tab

e Stamp/Background

Car on 5300 |'roperties

Main |F'age Setupl Stampx’BackgroundI Effectsl F‘rofilesl Maintenancel

Tab

Media Type: IF'Iain Paper j
Paper Source: IAuto Sheet Feeder j
Print Quality: " High
:= ¥ Standard
b
" Dialt
 Cusztamn SEb.
Color Adjustment: & Ayto
= £ Manual Set.
. Letter
88| Narmal-size Printing [T Grayzcale Printing
Stamp: Mone
Background: Mone
Effects: MHone
@' Print Advizor.
About | Defaults I
ok I Cancel | Pt e[ | Help |

e Effects Tab
* Profiles Tab

Note

— o Maintenance Tab

» The screens in this section refer to Windows 98/Windows Me operation.

The equivalent screens for Windows 2000 and Windows XP may look

slightly different.

Printer Properties Dialog Box Description

22



Main Tab

Printer Driver Functions (Windows)

Canon 5300 Properties 2] x|
Main |F'age Setupl Stampa’Backgroundl Effectsl F'rofilesl Maintenancel
Media Type: IF'Iain Paper L: (1 )
Paper Source: IAuto Sheet Feeder hi
Prrint B uality: = High
(+ Standard (2)
" Diaft
(6) — “ LCustom SEf.
Color Adjustment: [ & Auto (3)
i  Manual Sl
. Letter
8| Warmal-zize Printing ™ Grayzcale Printing (4)
Stamip: Mone
Background: Mone
Effects: MHane
About | Defaults |
Ok I Cancel | Apply | Help |

Media Type

Ensure that this setting matches the type of media loaded in the printer.

Print Quality

Select the print quality you require from among the different options. For a custom

print quality, select Custom, then click Set.

Printer Properties Dialog Box Description
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Printer Driver Functions (Windows)

(3) Color Adjustment
Select the method of color adjustment. To make detailed color adjustments, select
Manual, then click Set.

(4) Grayscale Printing
Select to print a grayscale version of a color document.

(5) Print Advisor
Click to start the Print Advisor.
The Print Advisor simplifies configuration of the printer driver. By having the user
answer a series of questions, the Printer Advisor automatically configures the printer
driver settings.

(6) Preview area
Before printing, verify that settings such as the lever position are correct.

Note » To see a description of any item in the Printer Properties dialog box, click
the ? mark, then click the desired item. To see a description of operating
procedures, click Help. If Help does not appear when using Windows 2000
or Windows XP, click Start, then select Programs (or All Programs), then
Canon S300, then Guide.

Printer Properties Dialog Box Description 24



Printer Driver Functions (Windows)

Page Setup Tab

Canon 5300 Properties 211

Main  Page Setup Stamp.-"Bac:kgroundI Effectsl Profilesl Maintenancel

g-'ll Page Size: Letter 8.50 % 11.00 in (1 )
4+ Oriertation: ' Porlrajt @ " Landscape (2)

EF‘_rinterPaperSize: I Letter 850« 17.00 in j

Frinting Type: [l Marmal-size Printing j (3)

(7) =——
" Duplex Frinting: (4)
Staple Side; & Long-sidestapling € Short-side stapling
i

. Latter LCopies: |1 3: [1-999)
58| Mormal-size Printing B Fevms O (5)
[ Callate (6)

\ y
Frinter contral.. I Defaults |

0k I Cancel Apply | Help |

(1) Page Size
Ensure that the correct paper size is selected.

(2) Orientation
Select landscape or portrait printing and ensure that it is the same orientation used in
the application.

Printer Properties Dialog Box Description 25



(3)

Printing Type

Printer Driver Functions (Windows)

Select the printing method from among the following:

Normal-size Printing
Fit to Page Printing

Scaled Printing

Page Layout Printing

Poster Printing

Banner Printing
Duplex Printing

The document is printed according to the original
dimensions. This setting is usually selected by default.
The document is automatically resized and printed to fit
into a specified page size.

The document is resized when printed. When this is
selected, you can specify the Printer Paper Size and
Scaling.

Pages are reduced and printed so that multiple document
pages fit on each printed page.

This enlarges and splits the print image across several
sheets of paper. The printed sheets can then be
assembled to make a large poster.

Select this when printing on banner paper.

The document is printed on both sides of the paper. After printing on one side, turn the
ejected page over, then print on the other side.

Reverse order

Prints the document start with the last page.

Collate

Select to print multiple copies of the document one copy at a time.

Preview area

Verify the overall layout, stamps, background and other settings to be applied to the

print job.

Printer Properties Dialog Box Description 26



Printer Driver Functions (Windows)

Stamp/Background Tab

Canon 5300 Properties
Main | Page Setup  Stamp/Background | Effectsl Profilesl Maintenancel
iDHAFT p ! (1 )
‘ Define Stamp... ;! (4)
I | Elace stamp e text (2)
s e e e (3)
‘i Background: iSampIe‘I a (5)
(8) ‘ Select Background... | (7)
I™ | Biackarourd firsh pame ork (6)
i
Stamp: Mone
B ackground: Mone
S
Diefaults |
kK I Cancel Sppli | Help |

(1) Stamp
Select the check box, then choose a stamp.

(2) Place stamp over text
When selected, the stamp is printed over the print data.

(3) Stamp first page only
When selected, the stamp is printed on the first page only.

Printer Properties Dialog Box Description 27



Printer Driver Functions (Windows)

Define Stamp
Use to create new stamps, or modify details for a selected stamp.

Background
Click to check, then choose the background image you wish to use.

Background first page only
When Background is checked, this option becomes active. When checked, the
background image is printed only on the first page.

Select Background
Click to select a new background, or to display the details of the background you have
selected.

Preview area

Printer Properties Dialog Box Description 28



Printer Driver Functions (Windows)

Effects Tab

Canon 5300 Properties 21x1
M ain I Page Setup | Stamp/Background  Effects | F'rofilesl Maintenancel
3 R
| (1)
Cantrast:
el =
Monochrome Effects
% Sepia ) Blue
) Bink € Green 2
£ Select Colour ( )
[Eolaur: ﬂ j
[~ Vivid Photo (3)
i
Effects: Mone I] ™ Image Optimiger (4)
™ Phato Optimizer PRO (5)
™| &pply Thoughout Page y
Defaults |
ak. I Cancel Aol I Help |

(1) Simulate lllustration
This function lets you apply graphic effects to a color image without affecting the
original document. Select the check box, then adjust the image brightness with the
Contrast slider.

Printer Properties Dialog Box Description 29



Printer Driver Functions (Windows)

Monochrome Effects
Prints a color image in a single color. Select the check box, then choose a color or use
a custom color using Select Color.

Vivid Photo

With this function, you can reproduce breathtaking sceneries in which colors,
especially blues and greens, appear even more vibrant. A major feature of this
function is its ability to create vivid backgrounds for fields, trees, oceans, and sky while
maintaining the natural skin tones of people who appear in the images.

Image Optimizer
Improves the contours and smooths jaggedness that occurs when photographs or
graphic image data is enlarged within an application.

Photo Optimizer PRO

Optimizes the color for images taken from a digital camera or scanner. It is especially
effective for images affected by color imbalance and over- or under-exposure.

When printing several images on one page, optimization is usually applied to each
image according to its requirements. However, if the image data has been
manipulated using cut-and-paste, rotation or other such operations, group
optimization of all images on the page is recommended. In such cases, select the
Apply Throughout Page check box.

Preview area

Printer Properties Dialog Box Description 30



Printer Driver Functions (Windows)

Profiles Tab

Canon 5300 Properties EE

tain | Page Setupl Stampa’Backgroundl Effects Profiles I Maintenancel

Printing Profiles etalls

Pararneter | Setting -
Media Type Plain Paper

Paper Source Auto Sheet Feeder

Print Quality Standard

Color Adjustment Auto (2)
Grayzcale Printing OFF |
Page Size Letter

Arent o

efault Settings

(1)

Orientation Partrait

Printing Type Mormal-zize Printing
Copiez 1
OFF

Reverse Order

ezcription:

Current Settings displayed. Click [Add to Profiles...] to add these print zettings ;I

to Printing Profiles. (3)
(4) Add to Profiles... | Eetieye e Brafiles | [elete : (6)

| ®
ak. I Cancel | Aol | Help |

(1) Printing Profiles
Displays the printing settings currently saved in the Profiles tab.
The Current Settings profile contains the settings currently specified in the Main,
Page Setup, Stamp/Background and Effects tabs. The Default Settings profile
contains the factory default settings.

Printer Properties Dialog Box Description 31



Printer Driver Functions (Windows)

Details
Displays all the printer settings selected in Printing Profiles.

Description
Displays a description of the printer settings selected in Printing Profiles. You can
enter the description when saving the printer settings.

Add to Profiles

Click to save the settings currently specified in the Main, Page Setup, Stamp/
Background and Effects tabs. Select Current Settings in the Printing Profiles list,
then click this button. The Add to Profiles dialog box will appear.

Retrieve from Profiles

Click to activate the selected printer profile settings. The contents of the Main, Page
Setup, Stamp/Background and Effects tabs are changed when a different profile is
selected. This button is disabled when Current Settings is selected.

Delete

Click to delete unwanted printer settings. Select the unwanted item in the Printing
Profiles list, then click Delete. Current Settings and Default Settings cannot be
deleted.

Printer Properties Dialog Box Description 32



Printer Driver Functions (Windows)

u
Maintenance Tab
Canon 5300 Properties HEI
General I [retails I Caolor Management I Sharing I E3 Main | @ Page Setup |
@| Stamp/Background I ## Effects I ﬁ Prafiles l"H Maintenance
H— -
Lleaning Dgepl:leaning 5
N ™ o |
®) —— by i (6)
—_i—
Print Head Alignment ﬂozzr Check. Power OIff Auto Power
(4)
(7) —— & $08) (9)
——
Ink Counter Reset Low Isn \_:_\.-"arning Custom Settings
Luly!
(8) :
% Start Status Monitar... l (1 0)
oK Cancel | Apply Help |

(1) Cleaning
Click to start printhead cleaning.
(2) Deep Cleaning
Click to start printhead deep cleaning.
Use this function only if Cleaning has not improved the print quality.

Printer Properties Dialog Box Description 33



Printer Driver Functions (Windows)

Printhead Alignment
Click to start the printhead alignment procedure. For details on printhead alignment,
refer to the printed Quick Start Guide.

Nozzle Check

Click to start a nozzle check print pattern. The nozzle check ensures that printhead
nozzles are outputting ink normally. For details, refer to “Examining the Nozzle Check
Pattern”.

Power Off
Click to turn the printer off.

Auto Power

Click to enable the printer to turn off automatically when no data is sent to the printer
for a certain period of time, and to automatically turn the printer on again when data is
sent to the printer.

Ink Counter Reset
Click to reset the ink counter to an initial value. Set the counter every time you replace
an ink tank. For details, refer to "Enabling Low Ink Warning".

Low Ink Warning Setting
Click to enable the low ink warning function. This function must be synchronized with
the ink counter to monitor ink levels. For details, refer to "Enabling Low Ink Warning".

Custom Settings
Click to modify the printer mode. Change the settings in the Custom Settings dialog
box, then click Send to change the printer mode.

Start Status Monitor
Click to start the BJ Status Monitor, which checks and reports the printer status and
the progress of printing jobs.

Printer Properties Dialog Box Description 34



Printer Driver Functions (Windows)

BJ Status Monitor Functions

The BJ Status Monitor displays the status of the printer.

If an error occurs, the status monitor indicates the nature of the error and suggests an
appropriate solution. When the low ink warning is enabled, the status monitor also checks
the ink tanks and displays a warning message when the ink is low.

B Launching the BJ Status Monitor

The BJ Status Monitor launches automatically when data is sent to the printer. When
launched, the BJ Status Monitor will appear as an icon on the taskbar.

7/ Click the Canon BJ Status Monitor icon on the taskbar.

(
] Slaltl“ E & = s |J Document - WordPad I &4t Canon BJ Background Mo...“ﬂh Canon 5300 - USBPFI__lo Canon BJ Status Moritor Va

The BJ Status Monitor will appear.

BJ Status Monitor Functions 35



Printer Driver Functions (Windows)

(i) Canon 5300 - USBPRNO1

Printing. ;I
The printer iz set not to dizplay a low ink
warning.

I

Paper Thickness Lever: Left

Document Mame: <03
Frint Page: 1

Progresz:  15% -

Lancel Printing | Drigplay Print Queue |

Note »  To open the BJ Status Monitor when the printer is not printing, click the
Maintenance tab in the Printer Properties dialog box, then click Start
Status Monitor.

BJ Status Monitor Functions 36



Printer Driver Functions (Windows)
B When errors occur

The BJ Status Monitor is automatically displayed when an error occurs, such as if the
printer runs out of paper or if the paper jams.
In such cases, take the appropriate action as described in the Printer Status tab.

In Windows 98 and Windows Me, click the Guide tab and follow the instructions on
screen.

When paper has run out:

(%) Canon 5300 - USEPRNO1 o) x|
Options  Part Help

|| Guide]

The printer iz out of paper. Load more paper, d
then press the RESUME button.

Paper Thickness Lewver: Left

Document Mame:  sample
Print Page: 1

Progress: FES .

LCancel Printing | Display Print Queue |

Note > For details on the BJ Status Monitor, click the Help menu, then click the
topic of interest.

BJ Status Monitor Functions 37



Printer Driver Functions (Windows)

Canceling a Print Job

To cancel the current print job, first open the BJ Status Monitor.

7/ Click the Canon BJ Status Monitor icon on the taskbar.

Frinting. ;I

The printer iz set not ko display a low ink
warning.

]

Paper Thickness Lever Left

Document Mame: =03
Frint Page: 1

Progress:  15% -

' LCancel Frinting | !Displm,| Frint Queue |

Note » If Cancel Printing is grayed out, press the RESUME/CANCEL button on
the printer to terminate the print job.

Canceling a Print Job 38



Printer Driver Functions (Windows)

Uninstalling Printer Drivers

Use the Uninstaller to delete the printer driver. The Uninstaller will delete all the files
associated with the printer driver.

7 Click Start, then select Programs, Canon S300, Uninstall.

For Windows XP, click Start, then All Programs, then Canon S300, then
Uninstall.

Click Yes when the confirmation message appears.

5 When all the files have been deleted, click OK.

The deletion of the printer driver is complete.
If a message prompts you to restart your computer, click OK.

Note »  In Windows 98 or Windows Me, you can also start the Uninstaller by
double-clicking on Uninstall in the Canon S300 folder on the desktop.
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Printer Driver Functions (Macintosh)
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Description of Print Settings

* Page Setup Dialog Box

Canon 5300 Version 3.9
0K I
Paper 5ize : [ Letter i]
-Cam:el
[ Banner Printing -
mn Scale: Ora @
Orientation :
[ save Settings
Height:11.00in Width - 8 50in
* Print Dialog Box
Canon 5300 Version 3.9 :]
_Print
Copies : El Pages: @ All ) From | | To | |
Bl Cartridge : Print Mode :
[ Color 2] m ’_| ’_| ’_I
Media Type : Detalls
[Plain Paper _] EurrentSettlngs Text
R Prmtl}ualltyI Normal (Fasth 'Em'
Paper Source: | Halftoning : Diffusion ;
[Al.ltﬂ Feeder i] EEolor[orrectlon:BJStandard ' Apply... '
[ Grayscale Printing

* Printer Utility
Dialog Box

* Detailed Setting
Dialog Box

* Options Dialog Box
* Register Settings

Description of Print Settings

Dialog Box
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Page Setup Dialog Box

The Page Setup dialog box contains settings for the printed page, such as the size of the
print media used and the image printed. To open the Page Setup dialog box, select Page
Setup from the File menu in your application program.

Version 3.9
Paper Size: [ Letter ;] -(1)
P . = Cancel I (2)

@)
]

[ save Settings (7)

Canomn 5300

7

[ Banner Printing

dewn Scale:

Orientation :

zight:11.00in Width : 8.50in

(1) Paper Size
Select the size of the paper for the print job from the drop-down menu. To enter the
size manually, select Custom 1 - Custom 3 and click Custom.

(2) Banner Printing
Select this check box when printing on banner paper.

(3) Scale
Specify the scaling percentage to resize the document for printing.

(4) Orientation
Select landscape or portrait printing.
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(5) Custom
To specify a custom paper size, select Custom 1 to Custom 3 from the Paper Size
pop-up menu (1), then click this button to open the Custom dialog box. In the Custom
dialog box, specify the length and width of the paper.

(6) Utilities
Click to open the Printer Utility dialog box for maintenance operations such as
printhead cleaning, nozzle check pattern printing and changing the print mode.

(7) Save Settings
Click to save the settings specified in the Page Setup dialog box.

(8) Preview area
Shows how the document will print with the selected paper settings.
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Printer Utility Dialog Box

The Printer Utility dialog box is displayed when you click Utilities in the Page Setup dialog
box.

Canon 5300 Printer Utility Version 3.8
(1) —([ Cleaning i])
2 Cleaning
( ) @ Starts print-head cleaning.

@ Deep Cleaning
Starts print-head deep cleaning.

Cooee

(1) Select the function you wish to perform.

(2) Display area showing the various maintenance functions, including cleaning and test
pattern printing. Click the icon to start this function. For further details, refer to
"Routine Maintenance".

m) Printing the Nozzle Check Pattern
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=) Printhead Cleaning
m) Printhead Deep Cleaning
=) Enabling Low Ink Warning

Note »  For information about printhead alignment, refer to the printed Quick Start
Guide.
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Print Dialog Box

The Print dialog box specifies the media type and print settings to be used for your print job.
To open the Print dialog box, click Print from the File menu in your application program.

Canon 5300 Version 3.9
Copies : I:l Pages: @ All O From | | To |

Bl Cartridge : Print Mode :

|
Color ]
IR —

(1) I'\Eledi? Type : — [M]'
Plain Paper i] Current Settings : Text (5)
- — Print Quality : Normal CFast) Options... =y
Paper Source: Halftoning : Diffusion
[Autn Feeder i] Color Correction : BI Standard ADD"}"... - (6)

(2) e [ ] Grray'scale Printing

(1) MediaType
Ensure that this setting matches the type of media loaded in the printer.

(2) Grayscale Printing
Click to print a grayscale version of a color document.

(3) Print Mode
Select the icon that most closely resembles your document and required print results.
(4) Details
Manually set the print quality and color settings in the Detailed Setting Dialog Box.
(This option is only available if Manual print mode is selected.)
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(5) Options
Specify the output destination, print order and page layout for the document you are
printing.

(6) Apply

Save print settings or implement previously saved print settings.
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Detailed Setting Dialog Box

To open the Detailed Setting dialog box, click Manual in the Print dialog box, then click
Details.

Canon Detailed Setting
. Print Quality: | Fast =(i=————o Fine
Qualit
uah i Normal (Fast) (2)
(1) ]
e
Special effects
ﬁ Halftoning : g (3)
Color R | R
Dither [_)lffusmn y
|~ || [Restore Defauits | cancel | [ oK ]l
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H Quality Panel

(1) Panel display icons
Click these icons to switch between panels in the Detailed Setting dialog box.

(2) Print Quality
Move the slider to adjust the balance between print quality and speed. Moving the
slider to the right enhances print quality, and moving it to the left increases printing
speed.

(3) Halftoning
Select either Dither or Diffusion ink dot configurations.
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B Special Effects Panel

To display the Special Effects panel, click the Special effects display icon.

Canon Detailed Setting

1] o

Restore Defaults |

[ Simulate illustration

(1)

Contrast: o——i—

[ Monochrome effects

@ Sepia ) Blue
71 Pink ) Green

()

71 Select color

[ Vivid Photo

] Photo Optimizer PRO

(3)
(4)

[ Apply Throughout Page

Cancel I 0K II

(1) Simulate illustration
This function lets you apply graphic effects to a color image without affecting the

original document. Select the check box, then adjust the brightness of the image with

the Contrast slider.

(2) Monochrome effects
Prints a color image in a single color. Select the check box, then choose a color, or

use a custom color using Select Color.
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(3) Vivid Photo
With this function, you can reproduce breathtaking sceneries in which colors,
especially blues and greens, appear even more vibrant. A major feature of this
function is its ability to create vivid backgrounds for fields, trees, oceans, and sky,
while maintaining the natural skin tones of people who appear in the images.

(4) Photo Optimizer PRO
Optimizes the color for images taken from a digital camera or scanner. It is especially
effective for images affected by color imbalance and over- or under- exposure.
When printing several images on one page, optimization is usually applied to each
image according to its requirements. However, if the image data has been
manipulated using cut and paste, rotation or other such operations, group optimization
of all images on the page is recommended. In such cases, select the Apply
Throughout Page check box.

(5) Preview area
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Hl Color Panel

To display the Color panel, click the Color display icon.

Canon Detailed Setting
Color Correction : [ Bl Standard ij (1)
Print Type : [Phutn ij—_ (2)
Huality Printer Profile : [Recommended by Canon = ]—_ (3)
ﬂ (D Gamma Correction: 1.8 l:O:'_ )—_ (4)
—r— =

Special effects Color Balance : 0 ————r——= (yan
. 0 l:é:m Magenta (5)

Color 0 t:é:- Yellow

1] :_ Black
(|ntensity: 1] :_ ) (6)

|~[| | Restore Defaultsl Cancel I

(1) Color Correction
Select a color correction method: BJ Standard, ColorSync or None. BJ Standard is
usually the optimum color correction method for printing with a BJ printer. When
ColorSync is selected, you should also specify the Print Type and Printer Profile
settings.
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(2)

Print Type

For printing that emphasizes intermediate colors, select Photo. For printing that
emphasizes the brightness of primary colors, select Graphics. For documents that
contain large amounts of a single color, select Spot Color.

Printer Profile
Select optimized color characteristics (a profile) for the media type and other factors.

Gamma Correction

This function adjusts the contrast on colors other than black and white. To adjust the
contrast, select the check box, then move the slider. Moving the slider to the right
darkens the entire image while increasing contrast in the lighter areas and decreasing
contrast in the darker areas.

Color Balance
Move the slider for each color to adjust the balance of color intensity. Moving the slider
to the right intensifies the color.

Intensity
Move the slider to adjust the print intensity. Moving the slider to the right increases the
density.
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Options Dialog Box

To open the Options dialog box, click Options in the Print dialog box.

Canon Options
Layout: [ 1Page/Sheet Printing i]
Page Order: [ Left to right = ] (1 )
Page Border: [None > ]
(7) —) [ Duplex Printing 5
Stapling Side: @ Long-side stapling ( )
2 Short-side stapling
Margin for stapling: E inch (0.0-1.2)
[ Fit-to-page Printing
Printer Paper 5Size: [ Letter S ] (3)
Destination : | Printer ¥ i . Ao
(4) L _]] % % O Printin reverse order (5)
*= 1 [Print collated pages (6)
Cancel ] [ 0K ]|

(1) Layout
Use this function to print more than one page on a single sheet of paper. Typically, this
is set to 1 Page/Sheet Printing. If another option is selected, Page Order and Border
can be specified.
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2 Page/Sheet Printing, 4 Page/Sheet Printing
Pages are reduced and printed so that two or four pages fit on each printed sheet.
You can also select page order and whether to place a border around each page.

Poster (Divided into 4) / (Divided into 9) / (Divided into 16)
These enlarge and split the page across several sheets of paper. The printed
sheets can then be assembled to make a large poster. You can also select Cut/
Paste lines and Cut/Paste string. To print only selected pages, click the specific
pages on the preview area.

Duplex Printing

The document is printed on both sides of the paper. After printing one side, turn the
ejected page over, then print on the other side.

Fit-to-page Printing

Executes scaled printing automatically. When selected, you can specify the Printer
Paper Size. This fits the document paper size set in the application to the selected

paper size.

Destination

Select the print output destination. Printer is the usual selection. To check the layout
or other image elements before printing, select Preview. To save the document as a
PICT file, select PICT File.

Print in reverse order
Prints the document starting with the last page.

Print collated pages
Prints multiple copies of the document one copy at a time.

Preview area
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Register Settings Dialog Box

To open the Register Settings dialog box, click Apply in the Print dialog box.

Canon Register Settings
Settings : - 2
+Factory Defaults ( )
Caomy 1 ©)
| | Remove (4)
<l [ pefauits ——(5)
Settings
Displays a list of registered (saved) print settings.
Import

Imports a group of saved printer settings. To use the settings, select the desired
settings in the Settings list, then click Import.

Apply

Saves the settings currently specified in the Print dialog box. After clicking the button,
enter the name under which the settings are to be saved.

Remove
Deletes unwanted print settings. To delete unwanted settings, select the settings in
Settings, then click Remove.

Defaults
Causes the selected settings to be used as the default on new documents.
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BJ Print Monitor

The BJ Print Monitor displays the progress of print jobs.
You can launch the BJ Print Monitor if background printing is enabled in Chooser.

B Opening the BJ Print Monitor
7 Click Chooser from the Apple menu.

2 Set Backgrounding to On.

= (hooser—————H

Connected to :
5300 1

5300

-

-

Backgrounding
@ on G on

(=] ;
1= (3 Active
AppleTalk )
= @ Inactive 7.6.2

S After starting a print job, select BJ Print Monitor in the application menu.

The BJ Print Monitor launches.
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B BJ Print Monitor Functions

Bl PrintMonitor =—————FHIH

Printing...

Pages : 1/2,Copies:1/1

]
|

(] @ 2] [=] [ E—

Documen t Hame | User [ status [ Copies | Pages
s_19 nakanoo Printi... 1 2

D]

il [«]»

Printing... 7

... Click to pause printing of the specified document.
... Click to resume printing.
... Click to cancel printing of the specified document.

Displays the printer status. If an error occurs, instructions on what to |

do are displayed.
Displays the printer status and ink status with images.

— Displays information about the documents queued for printing.

The BJ Print Monitor allows you to change the print order of documents queued for printing.
To change the print order, place the mouse pointer over the name of the document, press
and hold the mouse button while dragging the document name to the new position, then
release. When the print order change includes the current job, the current job stops and the

new job immediately starts.
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Canceling a Print Job

When the BJ Print Monitor is running, you can use it to cancel or suspend the current print
job.

7 Select BJ Print Monitor in the application menu.

Z  Click the name of the print job you wish to cancel, then click [=.

The document selected in the Print Monitor is deleted from the print list and
the print job is cancelled.

Note > To suspend printing, click the name of the document being printed then
click [27]. To resume printing, click [2*].
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Using the Printer with a Network

The printer can be used with an Ethernet network environment. Follow the steps described
below to connect the printer to the network.

Bl Before Setting up the Printer
Install the printer driver on each network computer that will use the printer.

For information on installation, refer to the printed Quick Start Guide.

B Printer Setup

To use the printer on a network, first set up the print server, then set up each client
machine.

* Print server setup procedure
7 Select Chooser from the Apple menu.
Z Select Active in AppleTalk.

7 Select the S300 icon, then select the printer name in Connected to.
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4 Click Share.

5 Confirm that S300 server is selected in Enter new print server name,
then click Send.

6 Confirm that the new print server name has been added to Current print
servers, then click Close.

/~ Click the close box to close the Chooser.

e Client setup procedure
7 Select Chooser from the Apple menu.
Z Select Active in AppleTalk.

7 Select the S300 (Server) icon, then select the printer server in Connected
to.

4 Click the close box to close the Chooser,
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B Checking Print Status

* Checking print status from the print server
To check the status of a print job from the print server, start the BJ Print Monitor by
selecting BJ Print Monitor from the application menu.
To close the BJ Print Monitor, select Close Status Window from the File menu.

* Checking print status from a client
To check the status of a print job from a client, start the BJ Status Monitor by clicking
the BJ Status Monitor icon in the BJ Extras folder.
To close the BJ Status Monitor, select Quit from the File menu.

* The BJ Print Monitor and BJ Status Monitor
The BJ Print Monitor and the BJ Status Monitor both display a list of information
concerning documents queued for printing. This information includes the document
name, number of pages, number of copies and the time the print job was accepted.
The total number of queued documents is also displayed.
The BJ Print Monitor allows you to change the print order of the queued documents.

m» BJ Print Monitor Functions
m) BJ Status Monitor Functions
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H BJ Status Monitor Functions

J=—————530%erver—"—~—— M08

Printing...

Pages :1/1, Copies : 1/1

—

Docurnent Mame Uzer I Status I Copies I FPagez

s 23 nakanoo Printi.. 1 1

4]

[«]»

Printing...

|

[ Click to pause printing of the specified document.
[ Click to resume printing.

Click to cancel printing of the specified document.

Note » « You can determine the owner of a computer by selecting the File Sharing

control panel and checking the Owner Name item.

* If you are using two or more printer servers, you can switch between the
BJ Status Monitor displays. Select Print Server from the File menu, then
select the desired print server and click OK.
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Uninstalling Printer Drivers

When a printer driver is no longer needed, use the Installer to delete all program files
associated with it at the same time.

Before proceeding, ensure that you save any unsaved files in any currently running
applications.

Load the Sefup Software & User’s Guide CD-ROM.

Double-click the Printer Driver folder.

Double-click the Installer icon.

When the Software License Agreement is displayed, click Accept.

Select Uninstall from the pop-up menu, then click Uninstall.

Y 00 A O N

Note If a warning message appears indicating that other applications are

running:

¢ Click Cancel and save the document(s) if there are any unsaved
documents open in the other applications.

* Click Continue to continue the uninstall operation.

6 After the uninstall is complete, a message will appear prompting you to
restart your computer. Click Restart.
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* When to Replace Ink Tank and Maintain Printhead
* Replacing an Ink Tank

* Printing the Nozzle Check Pattern

* Printhead Cleaning

* Printhead Deep Cleaning

* Enabling Low Ink Warning

* Transporting the Printer
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When to Replace Ink Tank and Maintain Printhead

When printing becomes faint or colors are incorrect, check if the printhead nozzles are
clogged and clean them first. Follow the procedures below and replace an ink tank if
necessary.

m) Printing the Nozzle Check Pattern
{ If the print quality is poor
m) Printhead Cleaning
¥ If the problem remains

m) Printhead Deep Cleaning
{ The problem continues

m) Replacing an Ink Tank

If ink tank replacement does not resolve the problem, the printhead may be worn out.
Contact the Customer Care Center.

Note » Iflow ink warning is enabled, you will be alerted when a tank is low on ink.

m) Enabling Low Ink Warning
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Replacing an Ink Tank

When replacing an ink tank, check the model number very carefully. The printer will not print
properly if the wrong ink tank is used, or if an ink tank is installed in the incorrect position.

¢ Black: BCI-24 Black
e Color: BCI-24 Color

Note » Damage caused by using a refilled cartridge is not covered by the Canon

warranty. Canon recommends using only original Canon ink tanks to
ensure the best quality.

7/ Ensure that the printer is on, then open the front cover.

The printhead holder moves to the left.
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Z Remove the empty ink tank.

Pull the tab on the ink tank toward you to release.

color black

Lift the ink tank from its slot.

Do not touch the lock lever; remove only the ink tank.

Important » « To avoid spilling ink, do not touch the bottom of an ink tank once you have
removed the protective cap.
¢ Discard empty ink tanks according to the local laws and regulations
regarding disposal of consumables.
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3 Unpack the new ink tank and remove the orange protective cap.

Important » < Do not re-attach the protective cap once you have removed it.
* To avoid spilling ink, do not touch the bottom of an ink tank once you have
removed the protective cap.
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4 Insert the ink tank into the empty slot.
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5 Press on the tab until the ink tank snaps firmly into place.

6 Close the front cover.

The printhead holder moves to the right. The ink tank installation process is
now complete.

Note » « To maintain optimal print quality, use an ink tank within six months of first
use.
* Once an ink tank has been used, do not remove it from the printer and
leave it in the open. Leaving an ink tank in the open will cause ink to dry,
and the printer may not function properly when the ink tank is reinstalled.
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Printing the Nozzle Check Pattern

Print the nozzle check pattern to determine whether the ink ejects normally from the
printhead nozzles, and to verify printhead alignment. Use this function when printed results
are blurred or the color is incorrect.

Nozzle check pattern printing can be executed from the Windows and Macintosh printer
drivers, or from the printer itself.

M Printing the Nozzle Check Pattern from the Printer Drivers

7 With the printer on, load a sheet of plain letter-size paper in the printer.

2 Open the Printer Properties dialog box.
m) Opening the Printer Properties Dialog Box

5 Click the Maintenance tab, then click the Nozzle Check icon.

When the confirmation message is displayed, click OK.

m) Examining the Nozzle Check Pattern
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7 With the printer on, load a sheet of plain letter-size paper in the printer.

2 Open the Page Setup dialog box.

The Page Setup dialog box can normally be opened by selecting Page
Setup in the File menu.

7 Click Utilities to open the Printer Utilities dialog box.

Select Test Print from the drop-down menu, then click the Nozzle Check
icon.

5 When the confirmation message is displayed, click OK.

m) Examining the Nozzle Check Pattern
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M Printing the Nozzle Check Pattern through the Printer
7 With the printer on, load a sheet of plain letter-size paper in the printer.

Z Press and hold the RESUME/CANCEL button until the POWER lamp
flashes twice.

m) Examining the Nozzle Check Pattern
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The nozzle check pattern should appear as follows when ink is discharging properly.
Examine the nozzle check pattern output by the printer.

Lines missing here indicate the
[ printhead requires cleaning.

A
o 0 0
D F
L 0 o [RARERRRRRRRE

Unevenness in these patterns
— indicates the printhead requires

alignment.
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Printhead Cleaning

Clean the printhead if you suspect that the nozzles might be clogged.
Head cleaning can be performed either from the printer drivers or from the printer itself.

Note » Cleaning the printhead consumes ink, so perform printhead cleaning only
when necessary.

B Cleaning the Printhead from the Printer Drivers

7 Ensure that the printer is on.

2 Open the Printer Properties dialog box.
=) Opening the Printer Properties Dialog Box

7 Click the Maintenance tab, then click the Cleaning icon.
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Select the ink nozzles to be cleaned, then click Execute.

All colors: All nozzles
Black: Black ink nozzles
Color: Color ink nozzles

When a confirmation message is displayed, click OK.

Ensure that the printer is on.

Open the Page Setup dialog box.

The Page Setup dialog box can normally be opened by selecting Page
Setup from the File menu.

Click Utilities to open the Printer Utility dialog box.

Select Cleaning from the drop-down menu, then click the Cleaning icon.
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5 Select the ink nozzles to be cleaned, then click OK.

All colors: All nozzles
Black: Black ink nozzles
Color: Color ink nozzles

B Cleaning the Printhead from the Printer

This operation cleans all nozzles, both black and color. Because this method also resets the
printer, any print data stored in the printer is lost.

7 Ensure that the printer is on.

Z Press and hold the RESUME/CANCEL button until the POWER lamp
flashes once.

The POWER lamp will start flashing as printhead cleaning begins. Do not perform any other
operations until printhead cleaning is complete. This takes about 50 seconds.

After printhead cleaning finishes, print the nozzle check pattern to verify that the printhead
nozzles are clean.

m Printing the Nozzle Check Pattern
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Printhead Deep Cleaning

If print quality does not improve by standard printhead cleaning, try deep cleaning, which is
a more powerful process. Perform printhead deep cleaning from the printer driver.

Note »  Printhead deep cleaning consumes ink, so perform this procedure only
when necessary.

7 Ensure that the printer is on.

2 Open the Printer Properties dialog box.
m) Opening the Printer Properties Dialog Box

Click the Maintenance tab, then click the Deep Cleaning icon.

When the confirmation message is displayed, click OK.
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7 Ensure that the printer is on.

2 Open the Page Setup dialog box.

The Page Setup dialog box can normally be opened by selecting Page
Setup from the File menu.

7 Click Utilities to open the Printer Utility dialog box.

Select Cleaning from the drop-down menu, then click the Deep Cleaning
icon.

5 Click OK.

The POWER lamp will start flashing as printhead deep cleaning begins. Do not perform any
other operations until printhead cleaning is complete. This can take up to two minutes. The
POWER lamp stops flashing when printhead cleaning is complete.

After printhead deep cleaning finishes, print the nozzle check pattern to verify that the
printhead is clean. If not, perform printhead deep cleaning again. If the printhead is still not
clean after the second deep cleaning, the printhead may be worn out. In this event, contact
the Customer Care Center.

=) Printing the Nozzle Check Pattern
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Enabling Low Ink Warning

When enabled, the low ink warning notifies you during printing if ink runs low. This feature
can be enabled or disabled from the printer driver.

B How Low Ink Warning Works

Enable the low ink warning when installing a new ink tank.
=» Reset the ink counter for the ink tank installed.
¥ When ink becomes low

The low ink warning alerts.

When you install a new ink tank

When you reset the ink counter, the counter will assume that the ink tank is full, regardless
of how much ink actually remains. Resetting the counter on a newink tank is the only way

to match the counter value with the actual ink volume, so you should only enable the low ink
warning and reset the ink counter when installing a new ink tank.

=) How to Display Accurate Low Ink Warning
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B Low Ink Warning Display

The "!" indicates that the ink is running low.

= (O]

Although printing is in progress, the Follawing ink;l
1 running law.
Color

]

Faper Thickness Lever: Left
. Document Mame:  untitled
B2

Prirk Page:
. el
The color ink tank roass
iS running IOW. Lancel Printing | Dizplay F‘rint_l]_ueuel

BJ Status Monitor (Windows)

Canon $300 Yersion 3.9
Document Name : untitled
Printing Page : 1 Pages 1 Copies
Printing :

: The color ink tank
Ink level ;[ 'L
B'ﬁ is running low.

BJ Status Dialog (Macintosh)
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Note »  When background printing is enabled, the low ink warning displays on the
BJ Print Monitor (Macintosh).

m) BJ Print Monitor

B How to Display Accurate Low Ink Warning

* Reset the ink counter every time you install a new ink tank.
The ink counter is only accurate when synchronized with the actual ink level.
To synchronize the counter with the actual ink level, the ink counter must be set on/y
immediately after installing a new ink tank.

* Do not reset the ink counter for an ink tank that is in use.
This would disrupt synchronization between the counter and the actual ink level.

Note » e Ink counters for black and color ink tanks work independently of each
other. However, both start counting at the time you enable the low ink
warning. If you did not reset the counter for a specific ink tank when it was
first installed, the low ink warning may not function correctly for that tank.
Do not reset the ink counter until you install a new ink tank. Also note that
the counter for each ink tank must be started separately.

* Refer to "Low Ink Warning Displays Ink Tank with '?™ if the ink tanks and
counters are not synchronized.
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Bl Setting Low Ink Warning

Note >»

Reset the ink counter every time you install a new ink tank. Otherwise, the
ink level will not display correctly.

* Enabling Low Ink Warning

7

2
3

7

Ensure that the printer is on, then open the Printer Properties dialog box.

m) Opening the Printer Properties Dialog Box

Click the Maintenance tab, then click the Low Ink Warning Setting icon.

Click Display low ink warning, then click Send.

Ensure that the printer is on, then open the Page Setup dialog box.

The Page Setup dialog box can normally be opened by clicking Page
Setup from the File menu.

Click Utilities to open the Printer Utility dialog box.
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7 Select Low Ink Warning from the drop-down menu, then click the
Remaining ink level setting icon.

4 Click Display low ink warning, then click Send.

* Resetting Ink Counter

Note » Do not reset the ink counter for an ink tank that is already in use.

7 Ensure that the printer is on and open the Printer Properties dialog box.

m) Opening the Printer Properties Dialog Box

2 Click the Maintenance tab, then click the Ink Counter Reset icon.

7 Select the ink tank just installed (black or color), then click Execute.

7 Ensure that the printer is on, then open the Page Setup dialog box.

The Page Setup dialog box is normally opened by selecting Page Setup
from the File menu.
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Click Utilities to open the Printer Utility dialog box.

Select Remaining ink level setting from the drop-down menu, then click
Ink Counter Reset.

Select the ink tank just installed (black or color) and click Execute.
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Transporting the Printer

Pack the printer carefully in its original packing materials.

If you do not have the original packing materials, pack the printer carefully and thoroughly in
protective material and place it inside a sturdy box.

7 Turnthe printer off.

2 Aiter making sure that the POWER lamp is off, unplug the printer.

Important »  To protect the printer from damage, do not unplug the printer while the
POWER lamp is lit or flashing.
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7 Remove the paper rest and the paper output tray.

S

==

4 Disconnect the printer cable from the computer and from the printer, then
disconnect the power cord from the printer.
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5 Secure the printer with adhesive tape as shown, then pack it in a plastic
bag.
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6 Attach protective material to both sides of the printer when packing the
printer.

Clearly label the box as "Fragile" if using a transport company.
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Printing Media

e Compatible Media Types

* Envelopes

* High Resolution Paper HR-101N

* Glossy Photo Paper GP-301N/GP-301
* High Gloss Photo Film HG-201

* Glossy Photo Cards FM-101

* Photo Paper Pro PR-101

* Photo Paper Pro PC-101S

* Transparencies CF-102

* T-Shirt Transfers TR-201

* Banner Paper

Printing Media
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Compatible Media Types

You can use the following types of paper and other media:

H Size

» Standard paper: From A5 size (5.83 x 8.27 in.) to legal size (8.5 x 14.0 in.)
* Non-standard paper: From 3.54 x 4.72 in. t0 8.5 x 23.0 in.
* Others: Envelopes (US Com. #10 and European DL)

Important » Do not use the following types of paper. Using such paper will not only
produce unsatisfactory results, but can also cause the printer to jam or
malfunction.

* Folded, curled or wrinkled paper

* Wet paper

e Paper that is too thin (less than 17 Ib.)

* Paper that is too thick (more than 28 Ib.)

* Picture postcards

* Postcards with an affixed photo or sticker

* Envelopes with a double flap

* Sealed envelopes

* Envelopes with an embossed or treated surface
* Paper with holes (such as loose-leaf paper)
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B Weight

17 to 28 Ib.
Do not use paper heavier than this as it could jam in the printer.

M Types

The following types of media can be used.
For more information about the media and the printing methods, refer to the specific
sections.

Plain paper: Refer to the printed Quick Start Guide.
) Envelopes
m) High Resolution Paper HR-101N
m» Glossy Photo Paper GP-301N/GP-301
m) High Gloss Photo Film HG-201
=) Glossy Photo Cards FM-101
m) Photo Paper Pro PR-101
=) Photo Paper Pro PC-101S
m) Transparencies CF-102
=) T-Shirt Transfers TR-201
=) Banner Paper
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Envelopes

Use US Com. #10 or European DL size envelopes.

B Preparation for Printing

7 Press down on all four corners and edges of the envelopes to flatten them
as shown below.

2 lfthe envelopes are curled, hold the opposite corners and gently bend
them in the opposite direction.

Ensure that the flap of the envelope is perfectly straight.

}
Lw‘///\l £
J

= N

/
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S Ifthe leading edge of an envelope is puffed up or curled, use a pen to press
the envelope flat and sharpen the crease.

Press the envelope completely flat,
working from the middle to the edge.

SSTURSC
X X O

* The above illustrations show a side view of the leading edge of the
envelope.

The envelopes may jam in the printer if they are not completely flat and the
edges are not aligned.

Ensure that no curl or puff exceeds 0.1 in.

B Unsuitable Envelopes

* Envelopes with an embossed or treated surface
* Envelopes with a double flap or pressure seals
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Printing Media

* Place envelopes lengthwise with the flap to the left and the address side facing upward.
 Set the paper thickness lever to the right.
* Up to 10 envelopes can be loaded at once.

Paper thickness lever

Note > If the envelopes still do not feed properly even after removing curl, clean
the paper feed roller.

1
2

Ensure that the printer is on, and that no paper is loaded in the printer.

Press and hold the RESUME/CANCEL button, then release as the
POWER lamp flashes three times.

The paper roller will rotate ten times as it cleans.

Repeat this three times.
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3 Load a sheet of plain letter-size paper in the printer.

4  Press and hold the RESUME/CANCEL button, then release as the
POWER lamp flashes three times to feed the sheet.
Repeat this three times.
If the printer still does not feed the envelopes through even after cleaning,
repeat Step 4 again.

B Printer Driver Settings

* Media Type: Envelope

* Page Size: Select either #10 Env. or DL Env. according to the envelope size you
are using

e Orientation: Landscape

B Handling of Printed Output

Remove each envelope as it is printed.

B Printable Area

= Printing Area
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High Resolution Paper HR-101N

This type of paper provides better color reproduction than plain paper. It is suitable for
printing business documents that feature graphics, and for photographs.

B Loading

* Load the paper with the whiter side facing up.

» Set the paper thickness lever to the left.
* Do not load paper higher than the limit mark. A maximum of 80 sheets can be loaded.

Paper thickness lever

Print side
(whiter side)
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B Printer Driver Settings

* Media Type: High Resolution Paper
* Page Size: Ensure that the setting matches the size set in the application.

Bl Handling of Printed Output

Do not allow more than 50 sheets to stack in the paper output tray. If the output paper is
curled, it may prevent the next sheet from being ejected. In this case, or if the ink takes a
long time to dry, remove each sheet as soon as it is printed.

B Printable Area

m) Printing Area
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Glossy Photo Paper GP-301N/GP-301

This media is thicker than High Resolution Paper, with a glossy printing surface to produce
printouts close to photograph quality.

B Loading

* Load the paper with the whiter side facing up.

» Set the paper thickness lever to the left.

* A maximum of 10 sheets can be loaded at once.

* When printing on Glossy Photo Paper GP-301, do not use a loading support sheet.

Paper thickness lever

Print side
(whiter side)
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B Printer Driver Settings

* MediaType: Glossy Photo Paper
* Page Size: Ensure that the setting matches the size set in the application.

Bl Handling of Printed Output

* Do not stack more than 10 sheets in the paper output tray.
* Do not touch the printed surface until the ink dries (approx. two minutes).

B Printable Area

=) Printing Area
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High Gloss Photo Film HG-201

This film has an extremely glossy surface, ideal for printing photographs with outstanding
results.

B Loading

* Load only one sheet at a time.

* Load the film with the cut corner at the upper right.

* If the film is curled, flatten it by curling in the opposite direction.
 Set the paper thickness lever to the left.

Paper thickness lever
Cut corner
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B Printer Driver Settings

* Media Type: High Gloss Photo Film
* Page Size: Ensure that the setting matches the size set in the application.

Bl Handling of Printed Output

* Remove each sheet as soon as it is printed.
* Do not touch the printed surface until the ink dries.

B Printable Area

=) Printing Area

High Gloss Photo Film HG-201 103



Printing Media

Glossy Photo Cards FM-101

Made of the same material as Glossy Photo Paper GP-301, this photo-size paper is
intended for printing images that cover the entire surface of the card, without a white border.
To take full advantage of FM-101, make the images slightly larger than the area indicated by
the perforations.

B Loading

* Load the paper with the glossy side facing up.

* Set the paper thickness lever to the left.

* A maximum of 20 sheets can be loaded at once.

* Do not use the loading support sheet provided with the package.

Print side
(glossy side)
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B Printer Driver Settings

* MediaType: Glossy Photo Cards
* Page Size: Canon 4 x 6 in.

Bl Handling of Printed Output

* Do not allow more than 20 sheets to stack in the paper output tray.
* Do not touch the printed surface until the ink dries (approx. two minutes).

B Printable Area

=) Printing Area

Glossy Photo Cards FM-101 105



Printing Media

Photo Paper Pro PR-101

This is thick paper with a treated surface that enhances gloss and provides superior color
reproduction. It is ideal for printing high quality photographs.

B Loading

* Load only one sheet at a time.
* Load the paper with the glossier side facing up.
» Set the paper thickness lever to the left.

Paper thickness lever

Print side
(glossier side)
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B Printer Driver Settings

* MediaType: Photo Paper Pro
* Page Size: Ensure that the setting matches the size set in the application.

Bl Handling of Printed Output

* Remove each sheet as soon as it is printed.
* Do not touch the printed surface until the ink dries (approx. 30 minutes). Colors in dark
images may appear indistinct at first, but become clearer after about 30 minutes.

* Images may smudge if you place them in an album before the ink is completely dry. It is
recommended that you allow the ink to dry for 24 hours.

* Do not attempt to dry the ink with a hair dryer or by exposing printed sheets to direct sunlight.

B Storing Printed Output

* Do not store or display printouts in hot, damp or humid conditions. Never expose them
to heat or direct sunlight.

* Store printouts in photo albums, photo frames or presentation binders to protect them
from direct exposure to air or sunlight.

* Do not mount printouts in an adhesive-type album, as you may not be able to remove them.

* Be aware that some types of clear plastic folders and albums may cause the edges of
the paper to turn yellow.

B Printable Area

=) Printing Area

Photo Paper Pro PR-101
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Photo Paper Pro PC-101S

Made of the same material as Photo Paper Pro PR-101, this photo-size paper is intended
for printing images that cover the entire surface of the card, without a white border. To take
full advantage of PC-101S, make the images slightly larger than the area indicated by the
perforations. This paper is ideal for printing high quality photographs.

B Loading

* Load the paper with the glossy side facing up.
* Set the paper thickness lever to the left.
* A maximum of 20 sheets can be loaded at once.

Paper thickness lever

/ Print side
/' (glossy side)
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B Printer Driver Settings

* Media Type: Photo Paper Pro
* Page Size: Select Custom Size and enter 4.67 x 8.5 in.

B Applications Settings
Enter 4.31 x 6.31 in. for Image Size.

For details on how to specify the image size, refer to the application’s user manual. You
may not be able to specify the size of the image correctly in some applications.

B Handling of Printed Output

Follow the instructions described in "Photo Paper Pro PC-101S".

H Printable Area

m) Printing Area
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Transparencies CF-102

This film is ideal for printing presentation material for use with overhead projectors.

B Loading

* Place one sheet of plain letter paper under the transparencies in the sheet feeder.
* Set the paper thickness lever to the left.
* A maximum of 30 sheets can be loaded at once.

Paper thickness lever

Plain paper

Transparencies
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* Although you can print on either side of CF-102, best results can be obtained by
printing on the side toward which it curls when held by the edge.

Print side

M Printer Driver Settings

* Media Type: Transparency
* Page Size: Ensure that the setting matches the size set in the application.

B Handling of Printed Output

* Remove each transparency as soon as it is printed.
* Do not touch the printed surface until the ink dries (approx. 15 minutes).

B Printable Area

m) Printing Area
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T-Shirt Transfers TR-201

This paper is used to produce iron-on transfers. The image is printed backward (mirror
image) when Media Type is set to T-Shirt Transfer in the printer driver.

B Loading

* Load only one sheet at a time.

¢ If the T-shirt transfer is curled, flatten it by curling it in the opposite direction.
* Load the paper with the side that does not have green lines facing up.

* Set the paper thickness lever to the right.

Paper thickness lever
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B Printer Driver Settings

* Media Type: T-Shirt Transfer
* Page Size: Ensure that the setting matches the size set in the application.

Bl Handling of Printed Output

* Remove each T-shirt transfer as soon as it is printed.

* The T-shirt transfer should be used as soon as possible. Refer to the supplied
instructions for details on how to use the paper.

H Printable Area

m) Printing Area
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Banner Paper

This is long paper that consists of consecutive sheets of letter-size paper, ideal for printing
long posters or banners (up to six sheets long).

B Preparation for Printing

* When tearing the banner paper, tear off one more sheet than you actually need to print.

* The maximum length for one print job is six sheets, so if you will be printing on six
sheets, tear off a seven-sheet length.

Bl Loading
7 Setthe paper thickness lever to the right.

Z Load the banner paper with the printing side facing up. Gently fold the
perforation between the first and second sheets.

Leave the rest of the paper folded up.
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3 Place the printer where the printed banner output can hang over the edge
of the table.

<

Ensure that the ink does not stain the table or floor.
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B Printer Driver Settings

* Media Type: Plain Paper
* Page Size: Letter

* Printing Type: Banner Printing
On a Macintosh, before creating the document, select Banner
Printing in the Page Setup dialog box.

* Copies: Must be set to 1 to print correctly.

M Printable Area

m) Printing Area
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Troubleshooting

Troubleshooting

* Cannot Install the Printer Driver

* Print Quality is Poor or Contains Errors

* Printer Does Not Start or Stops During Print Jobs
* Paper Does Not Feed Properly or Paper Jams

* The POWER Lamp Flashes Orange

* An Error Message is Displayed on the Screen

* Low Ink Warning Displays Ink Tank with '?"

* Problems Unique to Windows

* Problems Unique to the Macintosh
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Cannot Install the Printer Driver

B Follow the installation procedure correctly.

Install the printer driver carefully following the procedures described in the printed Quick
Start Guide.

If the printer driver was not installed correctly, reinstall it. If you are using Windows,
delete the printer driver before reinstalling it.

=) Uninstalling Printer Drivers
Note » If the Installer was forcibly terminated due to an error in Windows, Windows

may be unstable. This could prevent the printer driver from being installed.
Restart the computer before reinstalling the printer driver.

B Close any other applications before installation.

Sometimes the printer driver cannot be installed because another application is running.
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H If the Installer for the printer driver does not start automatically .
when you insert the Sefup Software & User’s Guide CD-ROM, open

the My Computer window, then double-click the CD-ROM icon.

Note »  If you choose to install from the Run command, specify the CD-ROM drive
letter and the installation file name ("msetup.exe"). The CD-ROM drive
letter is computer dependent.

B Confirm that there are no problems with the Sefup Software & User's Guide
CD-ROWM.

In Windows, use Explorer to ensure that the CD-ROM can be read. In a Macintosh,
check that the CD-ROM icon is visible. If there is a problem with the CD-ROM, contact
the Customer Care Center.
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Print Quality is Poor or Contains Errors

Troubleshooting

* Cannot Print to End of Job

* Colors are Unclear

* Meaningless Characters or Symbols are Printed
* Printing is Blurred/Colors are Wrong

» Straight Lines are Misaligned

* Printed Paper Curls or Ink Blots

* Back of Paper is Smudged

* Printed Surface is Scratched

* White Streaks

¢ Colors are Uneven or Streaked
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Cannot Print to End of Job

B Confirm that the Page Size setting matches the size of the paper loaded in the
printer.

First, check the Page Size setting in the application.

Next, check the Page Size setting in the Printer Properties dialog box for Windows, or
the Page Setup dialog box for Macintosh.

B Check the amount of the free space on the hard disk.

You may need to increase the amount of free space by deleting any unnecessary files.
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Colors are Unclear

B Confirm the Media Type setting in the printer driver matches the type of paper
loaded in the printer.

If you are printing a photograph or an illustration from a Windows environment, also

increase Print Quality on the Main tab.
If you are working in a Macintosh environment, select the Photo or Graphic icon for

the Print Mode in the Print dialog box.

B Confirm the specified ink tank is installed.

When an ink tank runs out of ink, replace it with a new one.

Note »  Printed colors may not match screen colors perfectly due to basic
differences in the methods used to produce colors. Color control settings
and environmental differences can also affect how colors appear on the

screen.
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Meaningless Characters or Symbols are Printed

Bl If the problem only occurs when printing a specific document, try editing the
document, then printing it.

If this does not resolve the problem, there may be a problem with your application
program.
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Printing is Blurred/Colors are Wrong

B Print the nozzle check pattern to ensure that ink is output correctly.

If the nozzle check pattern does not print correctly, clean the printhead.

=) Printing the Nozzle Check Pattern
=) Printhead Cleaning

If the problem is not resolved after cleaning the printhead several times, replace either of
the ink tanks. If print quality still remains poor, the printhead may be worn out. Contact
the Customer Care Center.

Note »  Always ensure that you dispose of the protective cap from a printhead.

B Ensure that you are printing on the correct side of the media.

You can only print on one side of certain media.
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Straight Lines are Misaligned

H Align the printhead.

7 Open the Printer Properties dialog box.
=) Opening the Printer Properties Dialog Box

2 Click the Maintenance tab.

7 Click Printhead Alignment.

Follow the instructions on the screen.
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7

>

Troubleshooting

Open the Page Setup dialog box.

The Page Setup dialog box can normally be opened by selecting Page
Setup from the File menu.

Click Utilities.

Select Test Print from the drop-down menu, then click Printhead
Alighment.

Follow the instructions on the screen.

Straight lines can become misaligned if the paper thickness lever has been
moved. Aligning the printhead may also resolve this problem.
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H In the printer driver settings, select a higher print quality setting.

Windows
Open the Printer Properties dialog box.

m) Opening the Printer Properties Dialog Box

Click the Main tab, then click High for the Print Quality setting.

Macintosh

\x. N \\.

Open the Print dialog box.

The Print dialog box can normally be opened by selecting Print from the
File menu.

For Print Mode, select Manual, then click Details.

3 Click the Quality icon, then drag the Print Quality slider to the Fine end.
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Printed Paper Curls or Ink Blots

B Use high resolution paper or photo paper to print images that require a lot of ink,
such as pictures with intense colors, or photographs.

B Reduce the Intensity setting in the printer driver and try printing again.

7 Open the Printer Properties dialog box.
m) Opening the Printer Properties Dialog Box

Z Click the Main tab, then select Manual for Color Adjustment, then click
Set.

3 Drag the Intensity slider to adjust the intensity.
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7 Open the Print dialog box.

The Print dialog box can normally be opened by selecting Print from the
File menu.

2 For Print Mode, select Manual, then click Details.

7 Click the Color icon, then drag the Intensity slider to set the intensity.
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Back of Paper is Smudged

Bl If the next page prints before the ink is dry, enable the Pause Page printer driver
setting.

You can either remove each printed sheet from the output tray as soon as it is printed,
or enable Pause Page to pause after each sheet has printed.

7 Open the Printer Properties dialog box.
m) Opening the Printer Properties Dialog Box

Click the Maintenance tab.
7 Click Custom Settings to open the Custom Settings dialog box.

Select Pause Page, then click Send.
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7 Open the Page Setup dialog box.

The Page Setup dialog box can normally be opened by selecting Page
Setup from the File menu.

2 Click Utilities.
7 Select Custom Settings from the drop-down menu.
Select Pause between pages, then click Send.

B You may need to clean some of the printer’s internal parts. To clean the inside of
the printer, follow the procedure below.

7 Load several sheets of letter-size plain paper into the printer's paper feeder.

Z Press and hold the RESUME/CANCEL button until the POWER lamp
flashes three times, then release the button. A test page will print.

3 Repeat this operation until there are no more smudges on the test page.
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Printed Surface is Scratched

B Ensure that you are using suitable paper.

* The paper weight must be less than 28 Ib.

If you use paper heavier than 28 Ib., the printhead may scratch the printed surface. Clean
the printhead first, then print with the correct paper.

* The paper must not be curled.

This problem can be resolved by simply turning the paper over.

B When printing on thick paper, set the paper thickness lever to the right.

This widens a gap between the printhead and the paper.

If the paper gets scratched when printing on plain paper, try setting the paper thickness
lever to the right. A message will display saying that the position of the lever is incorrect.
Ignore the message and continue printing.

B Reduce the Intensity setting in the printer driver and try printing again.
When printing an image with high intensity, especially on plain paper, the paper may

absorb too much ink and become wavy. This may cause the printed surface to become
scratched.
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7 Open the Printer Properties dialog box.
m) Opening the Printer Properties Dialog Box

2 Click the Main tab, then select Manual for Color Adjustment, then click
Set.

3 Drag the Intensity slider to adjust the intensity.

7 Open the Print dialog box.

The Print dialog box can be opened by clicking Print from the File menu.
Z  For Print Mode, select Manual, then click Details.

7 Click the Color icon and drag the Intensity slider to set the intensity.

B Ensure that you are printing within the recommended printing area.

=) Printing Area
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White Streaks

B Print the nozzle check pattern to check the ink output.

If a specific color does not print in the nozzle check pattern, clean the printhead.

=) Printing the Nozzle Check Pattern
=) Printhead Cleaning

The problem can also be resolved by aligning the printhead. For details on printhead
alignment, refer to "Straight Lines are Misaligned".
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Colors are Uneven or Streaked

H Increase the print quality setting in the printer driver settings.

Windows

Macintosh

7
2
7

Open the Printer Properties dialog box.

=) Opening the Printer Properties Dialog Box

Click the Main tab, then click High for the Print Quality setting.

Open the Print dialog box.

The Print dialog box can normally be opened by clicking Print from the File
menu.

For Print Mode, select Manual, then click Details.

Click the Quality icon, then drag the Print Quality slider to the Fine end.
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B Set the halftoning method to Diffusion in the printer driver settings.

7 Open the Printer Properties dialog box.
m) Opening the Printer Properties Dialog Box

2 Click the Main tab, select Custom for the Print Quality setting, then click
Set.

7 Click Diffusion for the Halftoning setting.

7 Open the Print dialog box.

The Print dialog box can normally be opened by clicking Print from the File
menu.

Z  For Print Mode, select Manual, then click Details.

7 Click the Quality icon, then click Diffusion for the Halftoning setting.
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Troubleshooting

Printer Does Not Start or Stops During Print Jobs

* Printing Does Not Start
* Printing Stops Before It is Completed
* Printer Moves But Does Not Print

* Printhead Holder Does Not Move
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Printing Does Not Start

B Ensure that the printer is turned on.

If the POWER lamp is off, press the POWER button.
If the POWER lamp is flashing green, the printer is initializing. Wait until the POWER
lamp stops flashing.

Note »  When printing a large amount of data, such as a photograph or illustration,
the printer may take longer than usual to begin printing. While the POWER
lamp is flashing, the computer is processing the data and sending it to the
printer. Wait until the green lamp stops flashing and printing begins.

B Ensure that the printer is securely connected to the computer.

Note »  If you are using a switch box or other device, remove and reconnect the
printer directly to the computer. Try printing again.
If printing is successful, there may be a problem with the device. Also, there
could be a problem with the cable(s). Replace the cable(s) and try printing
again.
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B Ensure that the correct printer driver is selected.

In Windows, ensure that Canon S300 is selected in the Print dialog box.
In Macintosh, ensure that S300 is selected in the Chooser.

Note » In Windows, you can set the Canon S300 as the default printer.

B Ensure that the printer port is set correctly.

Set "USBPRNnNNn" or "USBnnn" ("n" represents a number) as the printer port.
7 Click Start, then select Settings, Printers.
Select the Canon S300 icon.

Open the File menu and select Properties.

N QN

Click the Details tab (or Ports tab) and set the printer port.
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Printing Stops Before It is Completed

B Check the status of the POWER lamp.

When the POWER lamp is flashing green, the printer is processing data. Printing a large
amount of data, such as a photograph or illustration, takes time for the computer to
process, during which the printer may appear to not be functioning.

In addition, when continuously printing material that uses a large amount of black ink on
plain paper, the printer will sometimes pause. In either case, wait until the processing is
complete.

B Halt the print job and turn the printer off for at least 15 minutes to cool the printhead.

The printhead can overheat when continuously printing for a long time. To protect the
printhead, the printer will sometimes pause automatically at a line break before
resuming. In this event, interrupt the print job at a convenient time, then turn the printer
off for at least 15 minutes.

Furthermore, when continuously printing graphics or photos with intense colors, printing

may stop to protect the printhead. In this case, printing will not resume. Turn the printer
off and wait at least 15 minutes before turning the printer back on and reprinting the job.

Caution »  The area around the printhead inside the printer can become extremely
hot. Do not touch the printhead or nearby components.
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Troubleshooting

Printer Moves But Does Not Print

B Print the nozzle check pattern to ensure that ink is output correctly.

If the nozzle check pattern does not print correctly, clean the printhead.

=) Printing the Nozzle Check Pattern
=) Printhead Cleaning

If the problem is not resolved by cleaning the printhead several times, replace either of
the ink tanks. If print quality still remains poor, the printhead may be worn out. Contact
the Customer Care Center.
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Troubleshooting

Printhead Holder Does Not Move

B Ensure that the printer is turned on.

The printhead holder will not move unless the power is on. If the POWER lamp is off,
close the front cover and turn the power on.

If the POWER lamp is flashing green, the printer is initializing.
When the POWER lamp stops flashing, open the front cover again.
Bl If the front cover has been left open for a while, close and reopen it.

If the front cover is left open for more than 10 minutes, the printhead holder moves to the

right to prevent the printhead from drying out. Close and reopen the front cover to return
the holder to the center position.
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Troubleshooting

Paper Does Not Feed Properly or Paper Jams

* Paper Does Not Feed Properly
* Envelopes or Postcards Do Not Feed Properly

* Paper Jams
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Troubleshooting

Paper Does Not Feed Properly

B Confirm the paper conditions.

* The paper is not too thick (less than 28 Ib.).
¢ The number of sheets loaded does not exceed the recommended level.

* The paper is not creased, curled or wrinkled.
m) Compatible Media Types

B Ensure that the left edge of the paper just touches the paper guide.

B When printing envelopes, refer to "Envelopes" in "Printing Media", and prepare
the envelopes before printing.
Once you have prepared the envelopes, load them in the printer in portrait orientation. If
the envelopes are placed in landscape orientation, they may not feed properly.

B When using transparencies, load one sheet of plain paper in the printer first, then
place the transparencies on top of it.
The last transparency may not feed properly unless there is a sheet of plain paper

beneath it.
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Troubleshooting

Envelopes or Postcards Do Not Feed Properly

If envelopes or postcards do not feed properly even after removing curl, clean the paper
feed roller.

7 Ensure that the printer is on and no paper is loaded in the printer.

Z Press and hold the RESUME/CANCEL button, then release as the POWER
lamp flashes three times.
The paper roller will rotate ten times as it cleans.

Repeat this three times.
7 Load a sheet of letter-size plain paper in the printer.

Press and hold the RESUME/CANCEL button, then release as the POWER
lamp flashes three times. The sheet will feed through.

Repeat this three times.

If the printer still does not feed the envelopes or the postcards through after the cleaning,
repeat these procedures again.
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Troubleshooting

Paper Jams

Remove the paper according to the following procedure.

Note

7

2

3
>

Slowly pull the paper out, either from the sheet feeder or from the paper
output slot, whichever is easier.

If the paper tears and a piece remains inside the printer, open the front
cover and remove it.

If you cannot pull the paper out, turn the printer off and turn it back on. The
paper will be ejected automatically.

After removing all paper, close the front cover.

Reload the paper into the printer and press the RESUME/CANCEL button.

When reloading the paper into the printer, refer to "Paper Does Not Feed
Properly" to confirm that you are using the correct paper and are loading it
into the printer correctly.
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Troubleshooting

The POWER Lamp Flashes Orange

An error has occurred in the printer. The number of orange flashes between green flashes
indicates the type of error, as outlined below. Check the cause and take the appropriate
action.

B Two orange flashes: Out of paper, paper jam or paper feed error

Replace the paper correctly and press the RESUME/CANCEL button.
If paper has jammed in the printer, clear the jam and press the RESUME/CANCEL
button.

B Three orange flashes: Paper jam

If paper has jammed in the printer, clear the jam, replace the paper in the printer correctly
and press the RESUME/CANCEL button.

m) Paper Jams
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Troubleshooting

B Six orange flashes: No printhead installed
Install a printhead. If the error persists after the printhead has been correctly installed,
contact the Customer Care Center.

B Seven orange flashes: Defective printhead

Contact the Customer Care Center.

B Eight orange flashes: Waste ink tank almost full

The printer has a built-in waste ink tank for the ink used during printhead cleaning. Eight
flashes indicates that the waste ink tank is nearly full. Press the RESUME/CANCEL
button to cancel the error so you can continue printing. Before the waste ink tank
becomes completely full, contact the Customer Care Center to have the waste ink tank
replaced.

Note »  Canon recommends that you call the Customer Care Center for service as
soon as this error occurs. Once the waste ink tank becomes completely full,
printing will be no longer possible.
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Troubleshooting

B POWER lamp flashes alternate green and orange:
An error has occurred that may require you to contact the Customer Care Center.

Turn the printer off and unplug the printer from the power supply. Plug the printer back in
and turn the printer back on. If the problem remains, contact the Customer Care Center.
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Troubleshooting

An Error Message is Displayed on the Screen

* Error Writing to USBxxx

e Application Error or General Protection Fault

e Other Error Messages @HEETE

* Other Error Messages QUEERIGE)
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Troubleshooting

Error Writing to USBxxx

B Ensure that the printer is turned on.

If the POWER lamp is off, turn the printer on.
If the POWER lamp is flashing green, the printer is initializing. Wait until the POWER

lamp stops flashing.

B Ensure that the printer is securely connected to the computer.

Note » If you are using a switch box or other device, remove and reconnect the
printer directly to the computer and try printing again.
If printing is now successful, there may be a problem with the device.
Also there could be a problem with the cable(s). Replace the cable(s) and
try printing again.

Bl If spooling is enabled, disable it to send the print data directly to the printer, then
try printing again.

7 Open the Printer Properties dialog box from the Start menu.

m» Opening the Printer Properties dialog box directly from the Start
menu
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Troubleshooting

Z Click the Details tab, click Spool Settings, then select Print directly to
the printer.
In Windows 2000 or Windows XP, click the Advanced tab, then click Print
directly to the printer.

B Verify the USB port status.
7 Right-click My Computer and select Properties.

2 Click the Device Manager tab, double-click Universal Serial Bus
Controller, then double-click Canon S300.
In Windows 2000 or Windows XP, click Device Manager, click Universal
Serial Bus controller on the Hardware tab, then double-click USB
Printing Support.

7 Click the General tab, then check if there is any indication of a problem with
the device. In Windows 2000 and Windows XP, open the USB Printing
Support Properties dialog box to see the General tab.

If an error has occurred, follow the instructions in the Troubleshooting
section of the printed Quick Start Guide.
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Troubleshooting

B Ensure that the printer port setting corresponds to the printer interface
connection.

7 Open the Printer Properties dialog box from the Start menu.

m) Opening the Printer Properties dialog box directly from the Start
menu

Z Click the Details tab (or Ports tab), then select USBPRNnn (Canon S300)
or USBnnn (Canon S300) ("n" represents a number) from the Print to the
following port drop-down list.

B There may be a problem in the printer driver. Uninstall the printer driver and
reinstall it.

=) Uninstalling Printer Drivers
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Troubleshooting

Application Error or General Protection Fault

B Ensure that the application program you are using is intended for your operating
system.

For example, if you attempt to print with a Windows 3.1 application under Windows 98,
the application may not function correctly and an error may occur.
Use an application program intended for your operating system.

B If other applications are running, close them to increase available memory, then
try printing again.

B Ensure that enough memory is allocated to the application.

Refer to the memory requirements of your application.
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Troubleshooting

B Check the amount of free space on the hard disk.
You may need to increase the amount of free space by deleting any unnecessary files.
H If the problem occurs only when printing a specific document, try editing the
document, then printing it.

If this resolves the problem, there may have been a problem in the original document. If
the same problem occurs with the edited document, contact the manufacturer of your
application.

B There may be a problem in the printer driver. Uninstall the printer driver and
reinstall it.

=) Uninstalling Printer Drivers
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Troubleshooting

Other Error Messages

Bl If the BJ Status Monitor is displayed, follow the instructions on screen.

If an error occurs during printing, the BJ Status Monitor displays the error on the Printer
Status tab. Follow the instructions on the screen.

In Windows 98 or Windows Me, click the Guide tab for actions to be taken in response to
the error.

Refer to "Low Ink Warning Displays Ink Tank with '?" for more information.
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Troubleshooting

Bl If one of the following messages is displayed outside of the BJ Status Monitor:

Could not spool successfully due to insufficient disk space
Increase the amount of free space on the disk by deleting any unnecessary files.

Could not spool successfully due to insufficient memory
Increase available memory by closing any other applications currently running.

Printer driver could not be found
Uninstall the printer driver and reinstall it.

m) Uninstalling Printer Drivers

Background printing failed (Windows 98/Windows Me only)
Restart Windows and try printing again.

Could not print Application name — File name
Try printing again once the current job is finished.
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Troubleshooting

Other Error Messages

B If a message with the format "Error No.: Xnnn" (where "X" represents a letter and
“n" represents a number) is displayed:

Error No.: X202
Not enough memory for printing. Increase available memory by closing any other
applications currently running.

Error No.: X203
There is a problem with the printer driver. Uninstall the printer driver and reinstall it.

m) Uninstalling Printer Drivers
Error No.: X300
Ensure that the power is on, and that the printer and the computer are securely
connected. If the problem remains, verify the Chooser setting.

7 Inthe Apple menu, select Chooser.

2 Click the $300 icon and ensure that S300 is selected as the Connected to
destination.

If it is not selected, select it.

If the problem remains, delete all unnecessary documents from the Extensions and
Control Panels folder.
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Low Ink Warning Displays Ink Tank with '?"

Troubleshooting

The ink level of an ink tank displayed with a '?' is not synchronized with its ink counter.

(i) Canon 5300 - USEPRNO1

Optionz  Port Help
' 1| Guide]|

| LN

The color ink level

Frinting. ;I

The remaining level of the follawing ink is
unknowr;

Calor
There iz a possibility that the printer cannot
detect the remaining ink level properly. Reset
the ink counter uging the Maintenance tab of
the printer driver properties whenever pou have
replaced any ink tank with new one.

]

Paper Thickness Lever: Left

Document Mamme:  untitled
Prink Page: 9

> |

Progrezs:

may not be

Lancel Printing | Dizplay Frint Queue

indicated correctly.

BJ Status Monitor (Windows)

Printing :

Inklevel:@ ﬁ

Canon $300 Yersion 3.9
Document Name : untitled
Printing Page : 1 Pages 1 Copies

BJ Status Dialog (Macintosh)

The color ink level
may not be
indicated correctly.

Low Ink Warning Displays Ink Tank with '?'
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Troubleshooting

Note »  When background printing is enabled, the low ink warning displays on the
BJ Print Monitor (Macintosh).

m) BJ Print Monitor

B Reset the ink counter from the printer driver when you replace the ink tank.

m) Resetting Ink Counter

B Turn the low ink warning off until you replace the ink tank to stop the warning
message.

7 Ensure that the printer is on and open the Printer Properties dialog box.

m) Opening the Printer Properties Dialog Box

Z Click the Maintenance tab, click Low Ink Warning Setting icon.

7 Click to clear the check box for Display low ink warning, then click Send.
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Note

7

Troubleshooting

Ensure that the printer is on and open the Page Setup dialog box.

The Page Setup dialog box can normally be opened by selecting Page
Setup in the File menu.

Click the Utilities icon to open the Printer Utilities dialog box.

Select Remaining ink level setting from the drop-down menu and click
the Low Ink Warning Setting icon.

Click to clear the check box for Display low ink warning, then click Send.

Also refer to "Enabling Low Ink Warning" to display the ink level correctly.
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Troubleshooting

Problems Unique to Windows

* The BJ Status Monitor is Not Displayed

e Cannot Print in Background (Windows 98/Windows Me only)
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Troubleshooting

The BJ Status Monitor is Not Displayed

B Ensure that "Enable bi-directional support for this printer" is selected.

7 Open the Printer Properties dialog box from the Start menu.

m» Opening the Printer Properties dialog box directly from the Start
menu

Z Click the Details tab, click Spool Settings and select Enable bi-
directional support for this printer.

In Windows 2000 or Windows XP, select Enable bi-directional support on
the Ports tab.
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Troubleshooting

Cannot Print in Background (Windows 98/Windows Me
only)

B Check the amount of free space on the hard disk.

Background printing requires a certain amount of disk space. You may need to delete
unnecessary files, or disable background printing.

B Ensure that background printing is enabled.

7 Open the Printer Properties dialog box.
m) Opening the Printer Properties Dialog Box

2 Click the Page Setup tab, then Printer control, then Background
Printing.
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Troubleshooting

Problems Unique to the Macintosh

* Jagged Text or Graphics, or Banded Gradations

e Cannot Print in Background
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Troubleshooting

Jagged Text or Graphics, or Banded Gradations

B Ensure that your application supports Quick Draw.

If you are using a PostScript-compatible application, printed text and lines may appear
jagged and gradations may appear banded. As the S300 is not a PostScript printer but a
Quick Draw printer, use an application compatible with Quick Draw for printing.
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Troubleshooting

Cannot Print in Background

B Ensure that background printing is enabled.
7 Inthe Apple menu, select Chooser.
2 Set Backgrounding to On.

B Check the amount of free space on the hard disk.

Background printing requires a certain amount of disk space.
You may need to remove unnecessary files, or disable background printing.
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Specifications

Specifications

Printing method:
Bubble Jet on-demand

Printing resolution:
2400 (horizontal) x 1200 (vertical) dpi max.

Print speed (printing with Canon standard pattern):

Black printing Draft: 11 ppm
Standard: 9.5 ppm
Color printing Draft: 7.5 ppm

Standard: 4.1 ppm

Print direction:
Bi-directional

Print width:
8.0 in. max.

Resident print control mode:
Canon extended mode
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Specifications

Receive buffer:
56 KB

Interface:
USB 1.10-compatible

Interface connector:
USB standard Series B receptacle (USB interface)

Recommended printer cable:

Material: AWG28 (data wiring pair) or AWG20 to 28 (distribution pair)
Type: Twisted-pair shielded cable

Length: Up to 6.4 ft.

Connectors: USB standard Series B pluggable

Acoustic noise level:
Approx. 45 dB (A) (in the highest print quality mode)

Operating environment:

Temperature: 41 to 95°F
Humidity: 10 to 90%RH (no condensation)

Storage environment:

Temperature: 32 to 95°F
Humidity: 5 to 90% RH (no condensation)

Power supply:
USA/Canada AC 120V, 60 Hz
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Specifications

Power consumption:

Standby: Approx. 2 W
Printing: Approx. 30 W

Dimensions (without a paper rest and paper output tray):
15.7 (W) x 9.8 (D) x 7.3 (H) in.

Weight:
Approx. 7.5 Ib.
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Specifications

B Feed method:

Continuous feed through auto sheet feeder
For plain paper, envelopes, High Resolution Paper,
Glossy Photo Paper, High Gloss Photo Film,
Glossy Photo Cards, Photo Paper Pro,
Transparencies, T-shirt Transfers, Banner Paper

B Sheet feeder capacity:

Plain paper (17 Ib.) 100 sheets max.
High Resolution Paper 80 sheets max.
Envelopes 10 pieces max.
Glossy Photo Paper 10 sheets max.
High Gloss Photo Film 1 sheet

Glossy Photo Cards 20 sheets max.
Photo Paper Pro PR-101 1 sheet

Photo Paper Pro PC-101S 20 sheets max.
Transparencies 30 sheets max.
T-Shirt Transfers 1 sheet

Banner Paper 1 sheet
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Bl Ordinary print media:

Regular size: Letter, legal, A4, A5, B5, US Com.#10, European DL

Custom size: width: 3.54to 8.5in.
height: 4.72 to 23.0 in.

Weight: 17 to 28 Ib.

Canon Special media:

High Resolution Paper
Glossy Photo Paper
High Gloss Photo Film
Glossy Photo Cards
Photo Paper Pro
Photo Paper Pro
Transparencies
T-Shirt Transfers
Banner Paper

HR-101N
GP-301N/GP-301
HG-201

FM-101

PR-101

PC-101S
CF-102

TR-201

Specifications
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Specifications

B Graphic image printing:

Data format: Canon extended mode: Raster image format

Resolution: Canon extended mode: 300, 600, 1200, 2400 dpi
Bl Printhead:

Black: 320 nozzles (600 dpi)

Cyan, Magenta, Yellow: 128 nozzles per each color (600 dpi)

B Ink Tanks:

Capacity:
Black (BCI-24 Black)  approx. 300 ', approx. 5802
Color (BCI-24 Color)  approx. 1702

*1 1500 characters per page, normal text, at standard and plain paper mode with
Windows 98/Windows Me

*2. Based on printing the 1ISO JIS-SCID No.5 pattern at standard and plain paper
mode with Windows 98/Windows Me
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Specifications

B Printer driver operating environment:

IBM PC/AT-compatible computer running on Windows 98, Windows Me, Windows
2000, Windows XP or Macintosh computers with USB interface running on Mac OS
8.6 - Mac OS 9.X

B Hard disk space:

Approx. 15 MB to install on Windows 98 and Windows Me, 30 MB on Mac OS, or
approx. 25 MB on Windows 2000 and Windows XP (including temporary files)

Note > Use the system under the following operating environments:

Windows Computer with Microsoft Windows 98, Windows Me, Windows 2000 or
Windows XP which is pre-installed by a computer manufacturer on
purchase. USB port operation also needs to be assured by the
manufacturer.

Macintosh Macintosh computers with USB and Mac OS 8.6 - Mac OS 9.X, which is
pre-installed by a computer manufacturer on purchase.

Specifications subject to change without prior notice.
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Specifications

B Printing Area

To ensure the best print quality, the printer allows a margin along each edge of
media.

Printing area (dark blue): Canon recommends that you print within this area.
(- )

Printable area (light blue): The area where it is possible to print. However, printing
in this area can adversely affect the print quality or the
paper feed precision. ( 1 )

m) A4, B5, A5

m) | ctter, legal

=) Glossy Photo Cards

m) Photo Paper Pro (PC-101S)
=) Envelopes

E—

=) Banner Paper
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Specifications

A4, B5, A5
Size Printable Area (width x height)
A4 8.0 x 11.4in. (203.2 x 289.0 mm)
B5 6.9 x9.8in. (175.2 x 249.0 mm)
A5 5.6 x7.9in.(141.2 x 202.0 mm)
0.12in
AN

11.1 in

Bl Recommended printing area
1 Printable area

1'1.04 in

0.13in 0.13in
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Specifications

Letter, legal
Size Printable Area (width x height)
Letter 8.0x10.7 in.
Legal 8.0x13.7in.
0.12in
A

Vi

I Recommended printing area
1 Printable area

11.04 in

0.25in 0.251in
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Specifications

Glossy Photo Cards

Size Printable Area (width x height)

Glossy Photo Card 4.3 x6.3in.

Bl Recommended printing area
(Printable area is the same.)

1.02in

0.21in 0.16in
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Specifications

Photo Paper Pro (PC-101S)

Size Printable Area (width x height)
Photo Paper Pro PC-101S 4.3 x6.3in.

Note » The printing area of Photo Paper Pro PR-101 is identical to that of A4 size
paper. For details, refer to "A4, B5, A5".

1.1in

.
>

Il Recommended printing area

i (Printable area is the same.)
1.1in 7

e -

0.16in 0.16in
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Specifications

Envelopes

Size Printable Area (width x height)

US Com. #10 8.3x3.9in.

European DL 7.5x4.1in.(190.5 x 103.2 mm)

i [ Printable area
fro ™

0.12in 1.04in
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Specifications

Banner Paper

Size Printable Area (width x height)
Banner Paper Letter: 8.0 x 65.7 in.

i 10.12in Y

ARy , , , . . —

0.13in

0.13in Min. 2 sheets Max. 6 sheets

Il Recommended printing area
1 Printable area
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Index

Index

A
Application Error .. ... . 154

B
Background printing (Macintosh) .......... .. ... ... . . . . 57
Background printing (Windows) ........... .. .. . . 164
Banner Paper . ... 114
BCI-24 Black . ... ... 67
BCI-24 ColOr . . . o 67
BJ Print Monitor (Macintosh) ........ ... ... . . . . . . . 57
BJ Status Dialog (Macintosh) .......... ... ... . ... . . . 82, 159
BJ Status Monitor (Macintosh) ........ ... .. . . . . . . 63
BJ Status Monitor (Windows) ............................... 35, 82, 156, 159, 163

C
Canceling a Print Job (Macintosh) ........... ... ... ... ... .. . ... ... .. ... ..., 59
Cancelling a Print Job (Windows) ......... .. ... . .. 38
Chooser (Macintosh) . ... ... 57
Cleaning . ... 33,44, 76
Client (Macintosh) . ... ... . e 61
Compatible Media Types . ... 92
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D

Deep Cleaning . ... ...t 33,79

Duplex Printing . . ... 26, 55
E

Enabling Low Ink Warning .......... ... . 81

ENVvelopes . ... . 94

ErrorMessage ........... . 150, 156, 158
F
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G

Gamma Correction (Macintosh) ........ .. ... ... . . . . . . 53

General Protection Fault . ........ ... ... ... .. . . . 154

Glossy Photo Cards FM-101 ... ... .. ... .. . . e 104
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H
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High Resolution Paper HR-101N .. ... ... ... .. . .. . . . .. 98
]

Ink Counter Reset . ... . 34, 85
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L
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Printer Driver (WIindowsS) . ... ... .. 19
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Printer Properties Dialog Box (Windows) .......... ... ... ... ... .. ........ 20, 22
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